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Chapter | Introduction

l. Overview

LEDSHOWT?9 is professional software for LED display and control, which uses
advanced technologies, and has rich features, superior performance, good interface
and easy to use.

LEDSHOWT?9 support video, audio, images, text, Flash, Gif and other forms of
media file playback; support for Word, Excel, PPT display; support database
information display, support clock, time calculator, weather display; support for
external video signal ( TV, AWIi8eo) playback. Software supports mydige
multi-region program diting, providing a rich and flexible video effects, sub region
effects, as well as 3D effects. The software gives you a platform which can full extend
your imagination and help you makes&id program

LEDSHOWT9 suppoR§9,RDA8F (receiving card), sugort sending cards{[7)
send mode and Gigabit Ethernet send mode. LEDSHOWT9 can control more than one
LED display one a PC. LEDSHOWT?9 supports smart parameter setting and quick smar
parameter settings.

LEDSHOWT?9 support manual calorrection and, camex assistant
color-correction. LEDSHOWT?9 is compatible with other professional calibration
equipment.

LEDSHOWTO provides a rich language support, now supports Simplified Chinese,
Traditional Chinese, English, French, Japanese, Korean, Russian, Thanéolish
Spanish.

ll. Environment requirement
The software supports Windows X®indows Server 2003Vista\ Windows 7

and other operating systems. The recommended is:

CPU, 2.0 GHZ or above;

Memory, 1GB or more,

Graphics card, 256MB memory or more;

GigabitEthernet Or Send cayd
Users can adjust the configuration according to the actual situation. There are
the total number of pixels, the complexity of programs, and video size and definition .
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Chapter llInstallation and Uninstallation

|. Installation
1. Open the Clanddouble-click the Setup icon

(]
LEDSHOWT9_Setup_XX.X.XXXX.exe

(eg LEDSHOWT9_ Setup_11.2.1000.exe), select the sofimsadiation
language and click "OK".

Eﬁ Flease select a language.

|Engiish

Figure 21 select the installation language
2.Into the installation welcome screen. Click "Next"

r |

Welcome to the LEDSHOWT9
Setup Wizard

This wizard will guide you through the installation of
LEDSHOWTS .

It is recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Mext to continue.

Figure 22 Setup Wizard
3. Confirm the permission. Click "I Agree".
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LEDSHOWTS Setu

License Agreement
Flease review the license terms before instaling LEDSHOWTS | Lﬁ

Press Page Down to see the rest of the agreement.

Copyright. Protected by related polides.

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install LEDSHOWTS .

[ « Back “ I Agree I[ Cancel

)

Figure 23 License Agreement

4. Select the installation directory, and confirm the installation. Click "Install”
LEDSHOWTI Setu

Choose Install Location
Choose the folder in which to install LEDSHOWTS . Eﬁ

Setup will install LEDSHOWTS in the following folder. To install in a different folder, dick
Browse and select another folder. Clids Install to start the installation.

Destination Folder

:\Program FilesY EDSHOWTS

Space reguired: 38, 5ME
Space available: 51.2GE

| <Back | nstal | | cancel

Figure 24 choosing a location
5. Confirm the installation is complet€lick "Finish”
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Completing the LEDSHOWTS9 Setup
Wizard

LEDSHOWTY has been installed on vour computer.

Click Finish to dose this wizard.

=

Figure 25 installed
6. To complete the installation, the system will automatically generate a desktop
shortcul &2 |, doubleclick or open the software.

[ECERewT
0]

[1. Uninstallation

In the lower right corner of the computer the "Start" menu, select "All Programs
M [95{K2¢¢dh I ! yAyaualrtt b GKS az27F
| LEDSHOWTY
R LEDShowT9
{2 Uninstall
. LineKeng

; Maintenance -

1 Back

Figure 26 Uninstalling LEDSHOWT?9



E 2
ne Colorlight Quality Moving Color

Chapter Il LEDSHOWTOverview

|. Understand LEDSHOWT9 software interface
Start thesoftware, you can see the software interface shown in Figete Gonsists
of two parts: the playback window and the main interface

Play window

The main interface

I3 LEDSHOWT9 11.2 - new * C=I102]
e
File(E) Control(C) Tools(I) Language(l) Setting(S) Debug(D) Help(H) 1

DeEBE <&/ Il n @ 2 ﬁ
¥ X B ’—]4 3 ] . 5

[HI% @1
/ uormal Page 1 \

. & File Window
i hewildlife.wmy
: ~Multi-Line Text Window
{ [B-Single Line Text Window
: - Single-Line Text
- Normal Page 2
B File Window

- Hydrangeas.jpg
-~ Koala.jpa
i Penguins.jpg
\ / CopyRight @2008~2013
N
LED1,Space(347,179),Color(0,0,0) |User Real backgroud et LED screen, please go to "LED Admin

Figure 31 LEDSHOWT9 the main interface
1. Theplayback window
LED largescreen playback window is a preview window. In the window to see the
contents of the play is the LED display on the big screen. Note: When set to "Screen
capture mode " or use the T7 send cards, any player in the content winoesved
in the playback window or play the content on the big screen will be displayed in the
LED.
2.The main interface
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The main interface is divided into six regions, as follows: 1: menu; 2: The main
toolbar; 3: program editor toolbar; 4: The program traeea; 5: program property
area,; 6: The status bar.

Il. The program structure

LEDSHOWTO regional program tree composed by the four, followed by LED screen,
program pages, the program window and the playback bar.
= [

—=- Normal Page 1
LED screen . E-File Window
OTTOVV PayT Wildlife . wrmv
¢ e Multi-Line Text Window

. //El Single Line Text Window
Programwindow . Single-Line Text
“Tormal Page 2
= File Window
< - Hydrangeas.jpg
Play the content of Article -~ Koala.jpg
T Penguins.jpg

File Window Multi-Line Text Window

Single Line Text Window

Figure 32 shows schematic form
1 .LED screen: uséiendly LED big screen, big screen display by its decision. Each
b[ 95 aONXBSyé¢ Aa | LI NIf€tSt NBfFIGA2YAKAL
than oneprogram page.
2. Programme page: program page refers to a set of-deéned window and shows
a collection of programming content. Each "show page " and the order of play
between the parallel relationship.
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Page Properties

MName |Nu::rma| Page 1

Back Picture |Nn background picture j
Back Coior N
Back Music |ND background music ﬂ
Volume P "] 100

Play Management

{" SetDuration 1:00:00
{* Loop this page 0:00:30

Page Properties Figure3shows Figure
program window: the window is the broadcast program partition window, decided to

show page layout and stad&vel programs. Each "Show window " between the
parallel and simultaneous playback relationship.

Window Properties

Mame |File Window Maximum| Dutline [0 -
Starty |10 Width |22 Color
Startf |10 Height | 102 Layer | 3:Bot -

Total | 0:00:30 File count |1 [v Same Effect

Figure 34 shows the window attributes map
playback Article: LED screen in the specific content. Including video, pictures, text,
spreadsheet, database and other files, and clock, weather forecast, the external
video. Each "play content " is tied and the order of play between the relationship.
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—Image Properties
Path IF:‘n,leers‘Public‘Pin:h..lres‘ﬁample Pictures\Desert.jpa
Size w1024 H|[78 [ Reserve AspectRatio
Trans. """"""""""""'jW
—Effect Properties
None | Random |Repeat){ 1~ Repeat’fmr Connect
In IDI:Randnm ;I Time |5 100ms
Stay  |0D:No Effect ~] Time |50 100ms
Out IDI:Randnm ;I Time |5 100ms

Figure 35 shows the contents of property map
Note: Each LED screen shows the contents page and play the same level are

parallel between the relationship and in turn to play, and each program is a parallel
between the window and the relationship between botplayers.

1.  The menu and toolbar buttons
1.The main menu

File(E) Control(C) Tools(I) Language(l) Setting(S) Debug(D) Help(H)

Figure 36 Main menu bar
1.1. The File menu
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fFlIeIfE}I Control(C) Tools(T) Language(l)

New(N) | b 1
Open(0]...
Save(s)

Save As(A)...

Fa

Open Module(L)...
Save Madule(M)...

Program Package...

Convert Clv File... W
dow

Recent Files(R) F

Bait ()

Figure 37 File menu bar
On the File menu, the main achievement of program files (*. t9 files) and the
template file (*. t9temp file), open and othdxasic operations....

1.2. Control onscreen menu

LEDSHOWTS 11.2 - new
File(F) E Control{C) | Tools(T) Language(l) Setting(5)
D [ Screen Management(L)... i

Tirning Play Management(P)... 7

Timing Table(T)... I
=L View Receive Card Information...
: Rernote Operate LEDShowT9(R]...
By Point Color Correct(C) 3
Send A8 Content ul

Play Motification...
Sports Scores..,

Play PowerPoint(s)...

——

Close LED Screen(C)
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Figure 37 Control Screen Menu

Parameters used to set the playback window, the program's automated play,
view the version number to receive cards, temperature (need to install temperature
sensors), contrahreas, etc. For more information, remote desktop, large screen
brightness adjustment, emergency notification, sports scores, PowerPoint files, etc.
Special content playback control.
The "Send the contents of the A8, " is a special menu A8rdadé cardmemory
card to the receiver send video images or edited program; "off the large screen
display"is used to close / open LED display side of the display. After the closure of the
contents of a computer monitor is no longer visible on the screen simultangousl
sent to the LED display, suitable for editing program does not want to synchronize
the information displayed on the computer monitor to display the time used.

1.3 Tools menu

Tools(T) | Language(l) Setting(5) Debu
E Word(\W) | . 4
Excel(E) .

PowerPoint(F)
lage Properties

Paint(D)

WritePad(W) ath [P Ws
1Q .
i Calculator(C) . _ze W |—
Idlife..wmv Trans.

Figure 38 Tools Menu

Call the system software such as Word, Excel, PowsttRPoushes, WordPad,
etc., to facilitate editing program.
1.4. The language menu

For software installation is complete, change the software language.
1.5. Setup menu

10
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J | Setting(5) | DebugiD) HelpiH)

|| Software Setting(5)...
Hardware Maintain(W)...

Special Setting...
Uszer Admin(L]... =

Remote Control(R]... Em
Brightness Adjustrent(B]...

Check Point by Point(MEIS036)(D]...
ETICCT T O ueS”

Figure 39 Setup Menu
1} Software settings: The set of softwarelated, including the automatic settings,
network settings, other settings three tabs. Which the network settings for remote
operation
2] Hardware maintenance: For the upgrade of the control card, back to the time
parameters, and the software lock.
3] Special settings: The settings used for special modules.
4, User Management: LAN for remote management.
5] Remote Control: Remote control LED screen brightness, temperature, power
supply switch (requires mufunction card).
64 Brightness: The brightness of the display, temperature control, and power switch.
(Requires multfunction card)
7] Bypoint detection: To detect the polarization voltage LED lights to determine
whether there is a blind points. (Module IC is 5036.)
1.6. Debug menu
The menu offers a variety of tests used in the production, installation and
commissioning of the displayiode.
1.7. Help menu
Software used to view the help documentation, version information, and
computerrelated information. One can view the computer information to the CPU,
memory, graphics cards, network cards, sound cards, BIOS information.

11
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rCDﬂ’IpI.JtEf Infomation

Description

OS:Windows NT Server - Domain Controller

Open error
Total Physical Memory 2047 MB, Available 991 MB, Virtual Memory 1786 MB
Driver Total 298GE,Used 147GE, Available 150GE

Driver | Total(GE) | Used(GB) | Availablel... | Used(%:) | Available(2s) |
(HDD)C: 31.36 GB L.65 GEB 25.71GB 13% 82%

(HDD)D:  958.03 GB 47.21GE 50.82 GE 3% 52%

(HDD)E: 958.01GBE 74.82GE 23.18 GB 7% 29%

(HDD)F:  70.62 GB 19.61GE 51.01GE 27% 3%

(016G f.62GE 19.61GE 51.01GE 27% 3%

HDD 4,CD 1,M.0D 0

Expert

CPU | Memaory | Display | Netwc:rk|

Figure 310 computer configuration information
2.The main tool bar
Shows the main toolbar provides file operations, play window show / hide, dual
monitor switch, operation and A8 broadcast program recording and other functions
(Figure 311).
= H Z » 11 mn @ ?

Figure 311 the maintoolbar
3.The playback page context menu
In the play window, click the right mouse button pap menu (Figure-32), support
for various program files and broadcast operations for page switching.

12
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File Window Multi-Line Text Window

Recent Files(R) >

Single Line Text Window > Open(Q)...

i Save(S)
Play

Pause

Stop

Figure 312 Play page context menu
4. Program editingtoolbar

D+ @+ 3 XE

Figure 313 shows the Edit toolbar

Left to right:
1. new program page: Add the selected playback window shows page.
Add the contents of the window and pl&yArticle: position in the corresponding
window or play the content to add programs section.
2. Copy: Copy the selected items and all of the following content.
3. Paste: paste the copied content.
4. Move: Move the selected content to the front.
5. Move DownMove the selected content to the back.
6. Delete: Delete selected items and all of the following content.
7. Collapse / expand the program tree: Collapse / Expand the selected item, all the
contents.

13
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Chapter IV Program Editing

St the LECScreenSze

LED screenze must be set correctly, otherwise programming may show only
finished playing a part, or not display properly.

{SG aSGK2RY {StSOid

YSydz bYFAY YSydz a ONB

the pop-up screen management window, where to set the number of &&Bens,

starting position, size (Figurel4.

—Send Mode

¥ By Met Card " By Send Card

—Met Card Setting

IDefauIt vl MNotes |

Frames/s

¥ Param. From Computer ™ Param. From Receive Cards

¥ Use Net Card IReaItek PClIe GBE Family Contraller

~| Auto Selectl

Detect | |

—Control Area
Screen Count I] VI Config Selected One... |
X IU ¥ IU Width |255 Height |255 Apply | Cable Order (Front View) |From Right To Le
MNurmber X ¥ Width | Height Cable Order Parameters File Path

From Right To Left ~

D:\KwDownload\LEDSHOWTS  config_files\def.D

Figure 41 Screen Management window
Note that here the size of the corresponding LED screen LED display in the size of the actual,

general, and LED large screen set to the same

The new program page

size.

Youcan edit the toolbar button mouse click program

I Or click the button

14
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i Popup menu (Figure-2) shows the new page.

& -+

Blank Page

Figure 42 shows the new page

Establish program page, right side of the main interface will be shown in the
program related propertiepage (Figure-8), generally use the default parameter.

+ EE x &. Page Froperties
= LED1 Name INormal Page 1
i Normal Page 1
Back Picture |Nn background picture j

Backcoor

Back Music |Nn background music ﬂ

Volume |||||||||||||||||||||||||L]W

Play Management

(" SetDuration 1:00:00
{* Loop this page 0:00:00

LEDL, Space(449162), Color(D,0,0) User Real backgroud  |lease go to "LED Admin” to set it,
Figure 43 shows page and its properties

Page in the program can set the page properties window the following
attributes:

1. Name: Modify the name of the program pages;

2. Background Image: Youset a picture as a background image on page of the
program;

3.Background color: Click the color bar can choose any color as the background color
of the page program;

4. Background music: You can set an audio file as background music page of the
program;

5. Volume: Set the volume level of the background music;

6. Player Management: Setting page of the program broadcast time.

15
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One way: Specifies the playback duration. The program page to play a set time, a
program to jump to the next page play.
Second way: \ait for completion of the program broadcast page. Wait for the page
program after playing all the content, jump to the next page shows play
Add the Program Window
1.Add the program window
Establish program page, right click "show page"node or clicktlkten on the

toolbar nrogram
i'l' Popup menu to add programming window (Figuré} Shows the

location of the window can either drag the mouse can also be set using the
coordinates. A program page that contains any number of windows, window size and
position can be set.

‘LED1 Mame |Narme
& Normal Pa —
File Window lo ba

|
Multi-Line Text Window -
Single Line Text Window —
lo ba

Table Window

Clock Window L

Calculate Tirne Window
Extern Video Window
DataBase Window
Weather Window

Extern Application Window

Figure 44 shows the window to add
In accordance with the window to accommodate the different content, divided into
the following categories:
1. Document window: The window where you can play video, pictures, text, txt files,
tables, and flash, gif, etc.;
2. multHline text window: window can display multiple lines with complex formatting
text;
3.single line text window: window can display a line of text with a simple format;
4.table window: a window to display the form;
5. clack window: a window to display analog clock or digital clock;

6. Time window: window can display is timing, the countdown;
16
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7. external video window: The window where you can play external video. External
video contains an external video capture devigauiry such as cameras, video
cameras, TV cards, DVD, etc;
8. Database window: The window in the database can be displayed as a table form;
9. weather window: a window to display the weather forecast of domestic and
international cities (to be connected tbe Internet);
External window: external executable program can be displayed in the window;

2. Set the program properties
All the programs share a common property of the window (Figtisg 4

Window Properties

Name IW Maximum| Jutline [0 ~
Starty |10 Width | 223 Color

Starty [10  Height |90 Layer|1Top >
Total | 0:00:00 File u:u::untl[]i v Same Effect

Figure 45 shows the window attributes

1. Name: easy for users to distinguish between different window name can be set.

2. Maximize: make the window full screen in the LED screen.

3. Border: you can set the window border line width, in pixels.

4.Color: used to select the color of window berdine.

5. Starting point for X: Window LED screen relative to the upper left corner of the left
edge of the vertex position, in pixels.

6.Starting point for Y: the upper left corner relative to the LED screen on the vertex
position of the border, in piels.

7. Width: window width, in pixels.

8. Height: window height, in pixels.

9. Level: the window of the program page in the stack position relationship, "1:
top-level" as the first.

10. Total length: the window all the time required to broadcast.

11. Number of documents: This window shows the number of documents.

12. the same movie: set the window to play the content of all programs use the same
effects whether article

Add the playback section

17
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Add a window, according to the different window; add #@ggpropriate content
broadcast articles. Here to document that the window of the picture, right click
"show window " node or click the button, pagp menu. Select "Add Picture" pap
file selection dialog. Select a picture file can be used to play. Adténg the
corresponding LED window and the main interface as follows:

IEF LEDSHOWTO 11.2 - new *

File(F) Control{C) Tools(T) Language(l] Setting(s) Debug(D) Help(H)
O & & 2 rllm @ ?
+ [y < B Image Properties
= LED1 Path |F:EUsers‘lPublic\Pitthes‘.,Sample Pictures\Tulips.jpg
E-Normal Page 1 ) )
ey File Window Size w (fo24 H|768 [~ Reserve Aspect Ratio
TU|ID5._]|JQ Tl'ans. L T T T T T T T T S S O O R N Y R R O O I I I | Ii ,m
Effect Properties
Mone | Random |RepeatX|1 | Repeaty|l ¥ |~ Connect
i |01:Random ~| Tme |3 100ms
Stay  [0D:No Effect x| Time |5 100ms
Out |01:F‘.andom ﬂ Time |2 100ms
LED],Space(d43,116), Color(0,0,0) User Real backgroud  tware run.00:01:08 Mo network be seled

Figure 46 LED window effect

To this, programming the entire process to complete. According to actual needs

can then add and modify content, detailed operation described ifellewing
chapters.

18
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Chapter VEdit in Detailed

|. Pictures
1.Add a picture
Create a new "file window. " Right click "file window " or click the button

i'l' Popup menu and click "picture file", add one or more pictures.

+ EE’I A F;, Window Properties
- LED1 Mame |File Window Maximum| DJutline |0 -
=] Né?.rtnal Page 1 | s |5 - ’r coior
E Add Video...
Add Image... Startf |10 Height |9':I Layer |1:T°|:' ﬂ
Add RTF.. Total m File count IDi [v same Effect
Load Table...
Add Tit.. '
Add Flash...
Add Gif..,
Add Excel..,
Add Word..,
Add PowerPoint...
Full Screen
Remove
LED1, Space(275,106), Color(0,0,0) User Real backgroud  |oftware run.00:08:03 Mo network be sely

Figure 51 Add a picture
2.Image properties
Supports all image formats (BMP / JPG / PNG ...), image files, including the properties
and effects (see Figured.

Image Properties

Path |F:\,IJsers\Fuinc‘nFicthes‘nSample Pictures\Tulips.jpg

Size w {1024 H|768 [ Reserve AspectRatio
Tral-ls. I||||||||||||||||||||||||Ij IDDI:!;.I'D
Effect Properties

Mone | Random |F‘.Epeat!{|E| RepeatYIE [ Connect
In |01:Random | Tme[5  1o0ms
stay  |o0:No Effect =] tme[®®  100ms
out  |01:Random =] Tmel5  100ms

19
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Figure 52 Picture Properties

1. Full path: file path where the details of the computer.
2. Original size: width and height of theginal image.
3. Maintain the aspect ratio: the proportion shown by the original pictures.
4. Transparency: adjust the picture shows transparent effect free.

3. Effects settings
1.No special effect: the abolition of all effects shortcut buttons;
2. Random effects: set all effects for the random effect;
3. Cohesion: a program file is played before and after effects of a special effects show
the same admission and at the same time, this set will not be a black screen after the
player;
4. Effects epeat: You can put up window is divided into 16 small sections, use the
special effects, so that effect is more delicate;
5. Approach: when the screen into effect type;
6. Appearance: screen type exit effects;
7. Stay: pictures entering appearances lsefand after time spent in units of 0.1
seconds. Choose to stay Shihai flash features that make pictures more attractive
attention;
8. Time: speed is 0.1 seconds, that the current action to complete the total effect of
time, the smaller the value, the fis the action, said special effects;
The types of effects are present 50 species:

General 00: No special effects 01: Random

Edge covering | 02:Left cover 03:Right covey 04:Covered 05:Under the covel

Oblique angle of| 06: The upper lefcorner 07:Top right corney 08:The lower left

coverage corner; 09:The lower right corner

Straight angle | 10: The upper left corngr 11: Top right corney 12: The lower left
coverage cornery 13:The lower right corner

Blind 14:Horizontal blindg 15: Vertical blinds

16: Off abouf; 17:Outside the upper and lowgr 18: Closed

And closed off
around| 19:Closed down

20:Movey 21:Down| 22:Left] 23:Right

Translation :
24:Move the upper left corngr 25: Move the upper right corngr

20
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26: Move the bottom left corney 27:Move the botom right
corner

Mosaics

28: MosaicE Smal€ | 29:Mosaic$ In€ | 30:Mosaic$ Large

Rotation

32:D-36Q; 33:L-360; 34:D-180
35:L-:180; 36:D90; 37:L-90

From small to big

38: Intermediate 39: Left| 40: Upper righf 41: Left| 42: Lower right

Around the
middle ofthe

43:Rectangle 45:Diamond 47:Cross

Around to the
middle

44:Rectangle¢ 46:Diamond 48:Cross

D

49: A threedimensional animation 50: Second, threadimensional
animation

Other

31E Gradual change

Il. Video
1. add video

Create a new "file window. " Rigblick "file window " or click the button
+ Popup menu and click "video file", add one or more video files. At the
decoder (the decoder is recommended: the ultimate decoder) support, the
software supports almost all video format, AVl / MPEG / ASF /| WRWM./.

Figure 53 Add Video

2.Video Properties

21









































































































